Redlands Camera Club is a group of amateur, serious-amateur, and professional photographers who are interested in sharing
experiences and advancing their skills. Anyone with similar interests is encouraged to attend a meeting: no cost or obligation.

We meet at 7:00 pm on the first and third Mondays of every month at
Redlands United Church of Christ, 168 Bellevue Avenue, Redlands, CA (see back page for map).

December, 2011

KEH BUuUYINEG EVENT

Having KEH for a buying event was quite a success — you might say too successful.
We hadn’t anticipated such a short program - the program on the 21* set a club record
for brevity. Nor did the KEH rep. anticipate getting tied up in traffic and arriving late.
A third factor was the number of members with boxes & bags of items.

When 1 attended the Pasadena camera club meeting with Steve Felber and Rick
Strobaugh to see how the event worked, there were only a few people selling, and they
had only one or two items each. We certainly presented a different situation. This
combination of events led to many members planning to sell items having dead time on
their hands while waiting their turn.

We do apologize to our members who waited patiently, but could not stay longer.
KEH will be coming back in 2012 to provide another opportunity for our members. In
the meantime if you wish to deal with them directly by phone or on-line, check out the
details at KEH.com.

Jerry Reece, Secretary
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Tue View From HERE

Bruce Bonnett

I hope that all of you and your families had a good Thanksgiving and that you took the opportunity to
capture some special moments with your cameras. And as the December holidays and the New Year appear
before us, I challenge you to exercise the knowledge you have gained about photography. Move beyond the
simple snapshot and create powerful images that reflect the emotions of the events. To quote Brigitte
Bardot: “A photograph can be an instant of life captured for eternity that will never cease looking back at
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you.

I additionally want to invite all of you out to our Annual Pot Luck on Dec 19" beginning at 6:00 p.m. This
is always a fun time with good food and an opportunity to enjoy the camaraderie of your fellow
photographers. It’s also a time to see some of our best photographic works as the awards are presented for
the top images from our Fall Digital Competition.

As the New Year approaches, I wonder what photography of the future holds for us. The tools that we use to
capture images are changing at an absolutely breathtaking speed. Cell phones are having better and better
cameras that capture still, motion, and in a few cases even 3D images. A camera that lets you focus after you
shoot has been developed (Lytro). GigaPan technology and software is allowing the creation of
phenomenally detailed images with simple cameras and when combined with time lapse are creating what
has been dubbed a Time Machine. Cameras such as the GoPro are allowing individuals to capture still, time
lapse, and video images in locations and of activities that were previously available only to organizations
with very deep pockets. What’s next? Regardless of what’s developed, it takes the creativity, imagination,
and skill of the photographer to make memorable images. The question that each of us needs to ask is:
Where do we want to go with our creativity, and what tools do we wish to use to help us create it?

I wish you all a happy holiday season!
This month’s wisdom and humor:

e Dodging and burning are steps to take care of mistakes God made in establishing tonal relationships.
— Ansel Adams

e The term accessories has come to include a host of photographic gadgets of questionable value. -
Ansel Adams

e [t is more important to click with people than to click the shutter. — Alfred Eisenstadt
e The hardest thing in photography is to create a simple image. — Anne Geddes
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PROGRAMS Configuring Images for
Bruce Woodcock Digital Projection

DECEMBER 5™ solor Shace: SRon
PShop: Edit>Assign Profile>Working RGB=sRGB
Elements: Image>Convert Color Profile>Convert to sRGB Profile

Fall Digital Competition

Horizontal Image Size
1280 pixels on long side

The first meeting of the month is our Fall Digital Competition. Members . .

. . . . . Vertical Image Size
have entered their favorite images for presentation and judging. So come 768 pixels on long side
enjoy some fantastic photography from our members and see how they

File Size

do! Less than 3.5 mb (3500 kb)
The judges will evaluate each image based upon the following elements: Image Title

visual impact, creativity, style, composition, color or tonal harmony, | Stormy Weather (ormal punctuation)
center of interest, use of light, subject matter, storytelling, and technical File Name

stormyweather (no punctuation)
excellence.
Saving in the .JPG format will automatically
add the .jpg to the end of the file

DECEMBER 197
Holiday Pot Luck Dinner & Awards Presentation: Bring a dish to share

All members and their guests are invited to enjoy a fun evening of socializing with your fellow camera club
members. The club will provide drinks, silverware, and plates. You are requested to bring a dish that will
feed eight people.

Awards for the previous meeting’s digital competition will be presented, as will all the competition images
for your enjoyment.

COMPETITION

Russell Trozera

Well it is getting to look a lot like Christmas. It’s a photographer’s delight with all the wonderful entries for
the Winter Digital Competition.

There are 167 images submitted by 43 photographers. There were 16 Advance, 15 Intermediate and 12
Apprentice photographers. It was interesting to note that 19 entries were in Close-up, 34 entries in people,
21 entries in Places, 17 entries in Animals, 28 entries in Open / Misc., 35 entries in Land & seascapes and 13
in photojournalism. It was a splendid mix of images and photographers. There are some very outstanding
images.

Judging of the images will be at our meeting on December 5™ awards will be given at our dinner on
December 19th.

Happy Holidays to all.

Basking in the glow of your edited image

OK, you just spent 2 hours editing an image. Now's the time to view your handiwork in all its glory.
Hit the Tab key, then depress the "F" key twice (Elements: Tab then View>Fit On Screen or Cntrl 0).
This hides all the panels and toolbars, and lets you see the image by itself surrounded by black.




MEMBERSHIP

Bessie Reece

We are up to 175 members with new members are enrolling almost every meeting. Thanks to Frank Peele’s
photography classes, the publicity we are getting, and the recent display at the Ranch Mirage Library we are getting
several visitors at each meeting. Many of these visitors become members after their first visit. They are not only
impressed by the activities and opportunities we afford our members but also by the friendliness of our members.
Please welcome our new members:

Dene Shaver: Dene saw our club photo display at the Rancho Mirage Library and went to our website to
find out more about our club. She and her husband Phil moved to Rancho Mirage in 2007. They lived in
Idaho (very near the entrance to Yellowstone) previous to that. While there she became acquainted with her
neighbors who were professional nature photographers. They became her mentors and taught her much
about nature photography. Before this she would not even look at a camera if it had more that one button.
She enjoyed photographing the scenery and wildlife of the park no matter what the weather.

Dene currently shoots with a Canon 60D with lenses ranging from macro to telephoto. She has a 70-200 on
her wish list. Dene uses CS5 with Nik and Topaz plugins to process her images. She takes on-line classes to
improve her skills.

In addition to photography she has shown champion quarter horses, is an avid fly fisher, a bird hunter, and
has had field trial dogs. Presently she is a Commissioner for the City of Rancho Mirage Emergency
Preparedness Commission. While in Idaho she was a volunteer fireman and an EMT.

John and Nancy Teegarden: The Teegarden’s come from upstate New York where they met and married
47 years ago and have lived all over the country. John retired last January after working twenty years for
General Electric. His combined military service and private sector work has taken him all over the world.
John photographs anything associated with the outdoors. Animals and landscapes are his favorites along
with macro photography. He has used both film and digital cameras and currently uses both a Canon
PowerShot and a Canon Rebel.

Nancy focuses on taking family pictures; however, she also enjoys photographing the outdoors. She mostly
uses the Canon Rebel and also a point and a Canon SD1300 which she carries with her everywhere. Both
John and Nancy are looking forward to enhancing their photographic skills and taking the upcoming
Photoshop Elements 10 training. They are excited about what their membership in RCC has to offer.

Alice Lall: Alice is new to photography and recently completed Frank Peele’s class on Basic Photography.
She hopes to learn more about photography through her membership in Redlands Camera Club. She is a
semi-retired Registered Nurse, mother, and grandmother. She enjoys spending time with her grand children
and photographing them.

Arun Sivanandam: Arun is a 2nd year medical student pursuing an MD-PhD degree at Michigan State
University, who is currently on leave to rejuvenate himself. He has a younger sister and lives with her
family in Loma Linda. Arun states, “Our eyes are a window to the world, and I want to capture the beautiful
visions I see for lasting memories.” He loves to photograph architecture, flowers, sunrises and sunsets and
people in motion. He claims his experience is very limited, having just started working with a DSLR last
November.Specifically, he uses a Canon 60D DSLR and primarily works with a Canon 18-135 mm EFS IS
lens. For up-close shots, he uses a Canon 70-300 mm EF IS USM lens. Flash is handled with a Canon
Speedlite 430 EX 1.

Through his membership in the Redlands Camera Club, he hopes to get insight into correct angles, lighting
effects, proper post-processing touch-up techniques and the ability to take vivid pictures of the stars and the
moon. Non-photographic interests include car-racing/Formula I and reading fiction.



FieLD TriPs
Judith Sparhawk

Our December field trip will be holiday-based, and will be shooting the Christmas decorations and lights at
the Mission Inn in Riverside. Every year the Mission Inn is decorated with elaborate and festive decorations,
and they first light them the day after Thanksgiving. We will go in the late afternoon to stake out the area
while it is still light enough, and begin shooting as it becomes dusk, and then dark. If we time it right, we
should be able to get at least a few minutes of that gorgeous dark blue sky before it gets too dark.

In that we will be doing night shooting, we will need tripods. Your lenses will depend on what you wish to
shoot—zoom lens to get up close, wide angle for larger views, etc. The Mission Inn does not allow us on the
property, so we will need to be across the street; they usually have decorations on three sides, approximately
three blocks of shooting space. We can move around to find new things to shoot There should be a lot of
activity, including horse drawn carriages and perhaps lots of people visiting the Inn, or just spectators
viewing the sights. We do not want to be in the way, or to become a bother to the Inn.

We will go on Saturday, December 10. We should meet near the main entrance to the Inn, by 4:00 to 4:30
pm, to scout out the area and find our favorite spots, meet up, and get set up and ready. We can shoot as
long as we want, and if we wish, we can get together afterward for a bite to eat.

Directions: From Redlands, take the I-10 freeway toward the [-215 interchange. Take the 215 toward
Riverside; continue on the 215 past the 60 freeway, to the Mission Inn Blvd exit. At the end of the exit
ramp, turn right. The Mission Inn is about a block or two away. Parking may be an issue; park as close as
you can and walk back to the Inn. It is about 15 miles from Redlands, and will take about 20-30 minutes,
depending on traffic. Carpoolers should meet at Coco’s in Redlands at 3:15, to leave by 3:30 pm.

Keeping Sensors Clean (excerpted from Ask Tim Grey's daily eNewsletter of 5/6/11)

The ultrasonic vibration used by many digital SLRs to remove dust on the image sensor
will do a good job in many cases, especially in relatively dry environments
(moisture combined with dust can create very "sticky" problems).

While that might cause you to relax a little bit when it comes to avoiding dust,
turning off the camera when changing lenses will minimize the risk
of dust accumulating on the sensor.
When it is on, the electrostatic charge on the sensor attracts dust.
It is also a good idea to do your best to avoid dusty environments when changing lenses,
or at the very least make an effort to shield the camera when changing lenses.

It is worth noting that this issue is a big part of the reason there is a
special sensor cleaning mode on digital SLRs.

Obviously part of the issue here is to move the mirror out of the way,
but that could be accomplished with a bulb exposure (but don't do that!).
By using the special cleaning mode, you're not only causing the mirror to be moved
out of the way, but also causing power to be cut off from the sensor to avoid
the static that will attract the dust you're trying to remove.

If you do end up with dust spots visible in the image, all is not lost.
You can quite easily remove such dust spots in most cases by using one of the
several sensor cleaning products on the market.

RCC recommends the LensPen SensorKlear loupe kit.
It is very easy to use and allows you to see and clean at the same time.




WEBMASTER
Wayne (Woody) Wood

After several requests we now have a search engine on our web site. It can be found on the far right of the
menu bar which is located at the top of every page. You may use Google, Yahoo or MSN search engines to
search our web site. Please give it a try.

As most of you know, the opening page on our website showcases a member of our club each month. This is
a great chance to get your photos seen by a lot of people worldwide.

However, at least eight members have turned me down. I've heard excuses from "my photos aren't good
enough" to a flat "NO". Come on, folks. When you are asked to be the Featured Photographer how about
just saying "OK". Our club is about sharing and participating in club activities. I've heard nothing but good
comments about all the members that have agreed to showcase their photos.

We now have quite a few affiliate links on our web site.

Please consider clicking on these links if you are planning a photo or computer type of purchase. By going
to these seller's web sites through our links we will be paid a small percentage of each sale. It won't be
much, but at the end of the year it could wind up being a sizeable amount.

Affiliate Vendor Program

The businesses on the right have authorized RCC to become < = vl
part of their Affiliate Vendor program. Rl ol ez
When making photographic or computer-related purchases, you might want | <5~ & m . -
to consider them. They offer competitive pricing i = ‘ ..-.;
and good customer service. % oo -b.nk T —
carrot i [rosduarters
By entering their websites through the RCC website (click on the Affiliate e :{ sesicon §
Vendors link), they will apply a small percent of your purchase towards an e
RCC account without costing you anything extra! Jondc e A s olo
Please help RCC increase its treasury with this program so we can i) '2‘ = 1
offer our members more or better quality benefits. woot! é o o

Expose to the right

Subtle overexposure of RAW images can yield more detail and lower noise in finished photographs.
When establishing your exposure, place the peaks of a histogram right of center,
where brightness is represented.
The brighter the pixels, the more light and image-forming information they have captured.

But don't overexpose too much or you'll blow everything out. The idea is to move the peaks toward
the right side without allowing the graph to run off the end (called clipping).

Keep an eye on the histogram or check for "blinkies" on your LCD.
Clipping of the Histogram or blinkies indicate there is no detail, just blown-out white.
If you see them, back off on your exposure and try again.

After making this slightly overexposed RAW file, your job is only halfway done.

The next step is to use your RAW editor to ease the exposure back to a normal level,
paying special attention to highlight details.

At this point, you'll notice the major benefit of the subtle overexposure -- lower noise and higher detail,
particularlv in the shadows and when shooting higher ISOs.




MEMBERS’ GALLERY
2011 Intermediate & Advanced Print Competition: 3¢ Place Ribbons
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JPEG image degradation: (excerpted from Ask Tim Grey eNewsletter October 27, 2011)

Question: If I open a JPEG image and make a change to the metadata (for instance:
add a keyword, a country code, or revise the copyright) and then save it, does that also
constitute “a change to the image” — or is the image unaffected by such metadata editing?

Answer: When it comes to a JPEG image, any time you make a change that requires
the actual image file to be re-saved to your hard drive (or other storage location),
there is some degradation in image quality.

So if you change metadata for a JPEG, it is quite likely that the image file itself
1s being re-saved, and thus the image quality is reduced.

It is technically possible to update the metadata without re-writing the image file.
But this is a rare circumstance that most software does not support.
So, for all practical purposes, you can think that anytime you make a change to a
JPEG image and re-save the image file, there is some degradation of overall image quality.

If you are using software such as Lightroom that offers a non-destructive image-optimization
workflow, the rules here change a little bit, because when you save metadata updates
in Lightroom, the image file is not automatically re-written
(and thus no degradation occurs at that point).




Want to join or renew your membership?
Complete this form and bring it to a meeting, along with annual dues Where
Or Mail to: P.O. Box 7261 Redlands, CA 92375 (make check payable to: Redlands Camera Club)

Name: Phone: ( ) -
Name: Relation to above:
Street Address:
City: ST: ZIP: g
E-Mail: £
[ ] Member $25 [ 1 Additional Family Member $20
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Redlands Camera Club Redlands United Church of Chri
7:00 p.m. -- 1st & 3rd Mondays 168 Bellevue, Redlands, CA
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